
Metodologie pedagogického výzkumu I

• kurz pro prvńı ročńık magisterského studia oboru pedagogiky,
PedF UK

• rozsah kurzu: 1/1

• výuka prob́ıhá blokově ve dnech:

– pátek 6. listopadu, 14:25 až 20:25, R305

– sobota 7. listopadu, 9:00 až 15:00, R305

– neděle 8. listopadu, 9:00 až 15:00, R305

• zakončeńı kurzu: zápočet a zkouška

• požadavky ke zkoušce: ústńı zkouška a seminárńı práce (výzkumná
zpráva o realizaci vlastńıho výzkumu)

– výsledek zkoušky: 60 % známky tvoř́ı ústńı zkouška, 40 %
známky tvoř́ı seminárńı práce;

– ústńı zkouška i seminárńı práce budou hodnoceny na škále
1 až 10

– výsledná u zkoušky 1 bude odpov́ıdat 8.5-10, známka 2 bude
odpov́ıdat 7-8.4, známka 3 bude odpov́ıdat 5-6.9

– ústńı zkouška z metod pedagogického výzkumu a statis-
tiky využ́ıvané v pedagogickém výzkumu

– zkouška založena na odpřednášené látce během kurzu a disku-
tované literatuře během kurzu, studijńı materiály jsou dos-
tupné na internetové stránce
www.zla-ryba.cz/hanicka/metodologie

– v části metody pedagogického výzkumu si vylosujute dvě
otázky, které budeme následně po vaš́ı krátké př́ıpravě disku-
tovat

– v části statistika budete na poč́ıtači s využit́ım statistického
softwaru Gretl vyhodnocovat požadovaným zp̊usobem předložená

1



data (můžete si přinést vlastńı notebook s jiným statistickým
softwarem, který umı́te ovládat, a vypracovat předloženou
úlohu v něm)

– seminárńı práce: Výstižně popsat realizaci vlastńıho výzkumu!

– Ve vlastńım výzkumu je možné využ́ıt diskutovaných metod
během kurzu, popř. jiných relevatńıch metod, které odpov́ıdaj́ı
povaze zkoumaného problému.

– při psańı vaš́ı výzkumné zprávy vyjděte z šesti krok̊u, které
popisuj́ı jednotlivé kroky v provedeńı výzkumu (popis těchto
šesti krok̊u bude diskutován na přednášce, jedná se konkrétně
o obrázek popisuj́ıćı fáze výzkumu
metodologie scanner tables graphs/ Figure-1-1-reasearch-steps.jpg
na následuj́ıćıch slajdech, tento obrázek stejně jako daľśı
studijńı materiály si lze stáhnout na
www.zla-ryba.cz/hanicka/metodologie)

– citace literatury může odpov́ıdat požadavk̊um na citaci lit-
eratury pro časopis Pedagogická orientace :
http://www.ped.muni.cz/pedor/index.php?option=com content&view
=article&id=117&Itemid=96

– termı́ny k ústńı zkoušce:
8. prosince 2009 na katedře pedagogiky v R225, začátek v
13:00
14. prosince 2009 na katedře pedagogiky v R225, začátek v
13:00

– termı́n pro odevzdáńı seminárńı práce:
do 20. ledna 2010, seminárńı práci poslat emailem, př́ıjem
práce vždy potvrd́ım

• požadavky k zápočtu: návrh vlastńıho výzkumu

– při psańı návrhu vyjděte z šesti krok̊u, které popisuj́ı jed-
notlivé kroky v provedeńı výzkumu, viz obrázek
metodologie scanner tables graphs/ Figure-1-1-reasearch-steps.jpg

2



– ve svém návrhu popǐste, jakým zp̊usobem budete realizo-
vat tyto kroky ve svém vlastńım výzkumu (5 krok je např.
analyzováńı a interpretováńı dat, ve svém návrhu můžete
napsat, že hodláte využ́ıt regresńı analýzy pro vysvětleńı
vztah̊u mezi vámi zkoumanými proměnnými)

– termı́n odevzdáńı návrh̊u: 3. prosince 2009

– návrhy můžu vrátit k přepracováńı

• dotazy vždy zaśılejte elektronicky na:
h.vonkova@uvt.nl, h.vonkova@gmail.com, krizule@email.cz

• konzultace možné ve dnech:
6.11.- až 11.11.
7.12. až 15.12.
nutno předem domluvit pomoćı emailu

• výklad metod pedagogického výzkumu je založen předevš́ım na
dvou knihách:

– Gay, L.R., Mills, G.E., Airasian, P. Educational Research.
Competencies for Analysis and Application. Upper Saddle
River, NJ : Pearson Higher Education, 2008.

– Chrástka, M. Metody pedagogického výzkumu. Praha : Grada,
2007.

• výklad statistiky je založen předevš́ım na knize:

– Hinkle, D.E., Wiersma, W., Jurs, S.G. Applied Statistics for
the Behavioral Sciences. Boston : Houghton Mifflin, 2003.

• Daľśı studijńı materiály lze naj́ıt na internové adrese
www.zla-ryba.cz/hanicka/metodologie

– naskenované tabulky a obrázky z knih Gay (2008) a Chrástka
(2009) v souboru
metodologie scanner tables graphs.zip (15 jpg soubor̊u)

3



– př́ıklady dotazńık̊u v souboru metodologie dotazniky priklad.zip
(4 př́ıklady - dotazńık o kázni, manipulaci, PISA dotazńık
a SHARE dotazńık)

– teoretické a praktické základy pojmového mapováńı v souboru
metodologie pojmove mapy.pdf

– datové soubory použ́ıvané v př́ıkladech diskutovaných během
kurzu v souboru metodologie data.zip (12 datových sou-
bor̊u, které jsou odděleně uloženy v csv souborech, všechny
datové soubory jsou v excelovskem souboru data.xls na jed-
notlivých listech)

• Statistika v pedagogickém výzkumu je v našem kurzu vysvětlována
s minimálńım použit́ım vzorečk̊u a s d̊urazem na konkrétńı využit́ı
v reálných př́ıkladech.

• Teorie statistiky je vysvětlena buď pomoćı teoretických pouček
či pomoćı př́ıklad̊u. Určitá část teorie je vysvětlena pouze a jen
v př́ıkladech.

• K porozuměńı obsahu (předevš́ım statistiky) je pro většinu stu-
dent̊u velmi vhodné chodit na přednášky a sledovat výklad.

• Statistický software, který budeme využ́ıvat, se nazývá Gretl. Je
to free software (nic nestoj́ı) a lze si ho stáhnout z následuj́ıćı
internetové adresy:
http://gretl.sourceforge.net/win32/
na prvńı řádce této stránky naleznete soubor gretl-1.8.5.exe, stáhněte
(uložte) si ho na sv̊uj poč́ıtač. Následně ho otevřete - spust́ı se
t́ım instalace. Velmi doporučuji si software stáhnout a provést v
něm všechny př́ıklady a cvičeńı, které budeme diskutovat během
přednášky!

1 Metody pedagogického výzkumu

• Jednotlivé kroky v empirickém kvalitativńım i kvantitativńım
výzkumu
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metodologie scanner tables graphs/ Figure-1-1-reasearch-steps.jpg

• Charakteristika dobře zvoleného výzkumného tématu
metodologie scanner tables graphs/ Table-2-2-research-topic.jpg

• Rozd́ıly mezi kvalitativńım a kvantitativńım výzkumem
metodologie scanner tables graphs/ Table-1-1-research-type.jpg

• Typy kvalitativńıho výzkumu
metodologie scanner tables graphs/Table-1-2-research-qualitative.jpg

• Dotazńık - jak formulovat položky 1
metodologie scanner tables graphs/Figure-7-1-questionnaire-example-
items.jpg

• Dotazńık - jak formulovat položky 2
metodologie scanner tables graphs/Table-7-1-questionnaire-items.jpg

• Typy škál pro měřeńı postoj̊u 1 - Likertova škála
metodologie scanner tables graphs/Scales1-Likert.jpg

• Typy škál pro měřeńı postoj̊u 2 - bipolárńı škála, hodnot́ıćı škála
metodologie scanner tables graphs/Scales2-differencial-rating.jpg

• Typy měřeńı
metodologie scanner tables graphs/Scales2-differencial-rating.jpg

• Př́ıklady dotazńık̊u
metodologie dotazniky priklad.zip (dotazńıky PISA, SHARE, kázeň,
manipulace)

• Metody sběru dat ve výzkumném šetřeńı
metodologie scanner tables graphs/Table-7-2-collection-methods.jpg

• Pozorováńı - př́ıklad standardizovaného pozorováńı
metodologie scanner tables graphs/Pozorovani1.jpg., Pozorovani2.jpg,
Pozorovani3.jpg a Pozorovani4.jpg

• Pojmové mapováńı
metodologie pojmove mapy.pdf
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2 Statistika v pedagogickém výzkumu

2.1 Úvod, základńı pojmy

• Populace zahrnuje všechny členy definované skupiny.

• Výběr je podmnožina člen̊u populace.

• Deskriptivńı statistika je kolekce metod pro klasifikováńı a
sumarizováńı numerických dat.

• Inferenčńı statistika je kolekce metod, která umožňuje činit
závěry o charakteristikách populace na základě př́ıslušných charak-
teristik př́ıslušného výběru.

• Proces kódováńı zahrnuje připisováńı numerických hodnot kate-
goriálńım proměnným. (Zopakuj rozd́ıly mezi kategoriálńı, oridinálńı,
intervalovou a poměrovou proměnnou.)

• Data jsou v datovém souboru většinou organizována tak, že každý
řádek odpov́ıdá jednomu individuu a sloupec obsahuje data for
měřenou proměnnou.

2.2 Deskriptivńı statistika

2.2.1 Tabulka absolutńıch, relativńıch a kumulativńıch četnost́ı

Př́ıklad

Učitel bilogie zadal ve své tř́ıdě test z bilogie, v němž žáci dopadli
následuj́ıćım zp̊usobem (uvedeny známky z testu):
1,2,3,2,2,5,4,2,2,3,2,1,4,5,4,3,1,1,2,2.
Sestavte tabulku absolutńıch, relativńıch a kumulativńıch četnost́ı pro
zpřehledněńı výsledk̊u žák̊u z testu.

Řešeńı
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četnosti

známka absolutńı relativńı (v %) kumulativńı (v %)

1 4 20 20
2 8 40 60
3 3 15 75
4 3 15 90
5 2 10 100

celkem 20 100

Cvičeńı

Sestavte tabulku četnost́ı pro následuj́ıćı hodnoty:
0,1,1,2,2,0,1,1,2,0,1,1,2,0,2,2,2,0,2,1,2,1,1,1,1,1,1,1,1,1

2.2.2 Mı́ry polohy

Mı́ry polohy indikuj́ı centrálńı tendenci naměřených hodnot proměnné.

Pr̊uměr

• Pr̊uměr(mean) vypoč́ıtáme ho tak, že všechny hodnoty sečteme
a tento součet poděĺıme počtem hodnot.

• Pr̊uměr je nejčastěǰśı pož́ıvanou mı́rou polohy dat.

• Pr̊uměr je velmi ovlivněn extrémńımi hodnotami, tj. buď extrémně
malými či extrémně velkými hodnotami. (Pr̊uměr neńı robustńı
statistikou.)

• př́ıklad: pr̊uměr z hodnot 1, 2, 1, 1, 2, 1, 1 je roven 1.29; pr̊uměr
z hodnot 1, 2, 1, 1, 2, 1, 1000 je roven 144 →jedna hodnota v
datech zcela změnila pr̊uměr
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• Pr̊uměr nemá význam poč́ıtat u nominálńıch a ordinálńıch proměnných.
Využ́ıváme ho u intervalových a poměrových proměnných.

Medián

• Medián je bod, pod kterým lež́ı 50 procent hodnot (z toho
vyplývá, že nad ńım lež́ı taktéž 50 procent hodnot). Medián
lze také nazvat 50ti procentńım percentilem.

• př́ıklad: urči medián pro skóry 1000, 18, 3, 6, 12, 19, 21
řešeńı: data nejprve uspořádáme podle velikosti od nejmenš́ı po
největš́ı hodnotu 3,6,12,18,19,21,1000 ; prostředńı hodnota je 18
(před ńı jsou 3 hodnoty, za ńı jsou 3 hodnoty), medián je tud́ıž
roven 18

• př́ıklad: urči medián pro skóry 1000, 18, 3, 6, 1, 12, 19, 21
řešeńı: data nejprve uspořádáme podle velikosti 1, 3, 6, 12, 18,
19, 21, 1000, vzhledem k tomu, že máme lichý počet hodnot, tak
medián vypoč́ıtáme jako pr̊uměr dvou prostředńıch hodnot 12 a
18. Medián je tedy roven (12+18)/2=15

• Medián je oproti pr̊uměru robustńı statistikou, tj. neńı citlivý
na extrémńı hodnoty. Viz prvńı př́ıklad pro medián.

• cvičeńı: Porovnej pr̊uměrný a mediánový plat v České republice.
Je pr̊uměrný plat nižš́ı, stejný, či vyšš́ı než mediánový plat?

• Medián nemá význam poč́ıtat u nominálńıch a ordinálńıch proměnných.
Využ́ıváme ho u intervalových a poměrových proměnných.

Modus

• Modus je nejčastěǰśı hodnota v datech.
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• př́ıklad: urči modus pro následuj́ıćı data 1,2,1,3,2,7,1000,2,2,6,2
řešeńı: nejčastěji se vyskytuje hodnota 2, modus je tedy roven 2.

• Modus je robustńı statistikou, viz předchoźı př́ıklad (extrémńı
hodnota nemá na modus vliv).

• Modus můžeme určit pro všechny typy proměnných, tj. nominálńı,
ordinálńı, intervalové i poměrové proměnné.

Minimum a maximum

• Minimum je nejmenš́ı hodnota, maximum je největš́ı hodnota.

• př́ıklad: urči minimum a maximum pro následuj́ıćı data 2,-4,3,-
50,20,13,-14,23,-41
řešeńı: minimum je -50, maximum je 23.

• Minimum i maximum nemá význam poč́ıtat u nominálńıch a or-
dinálńıch proměnných. Využ́ıváme je u intervalových a poměrových
proměnných.

2.2.3 Mı́ry variability

Mı́ry variability indikuj́ı, jak naměřené hodnoty koĺısaj́ı, tj. jakou maj́ı
variabilitu.

Rozptyl, standardńı odchylka

• Rozptyl je definován jako pr̊uměr čtvercových odchylek jed-
notlivých hodnot od pr̊uměrné hodnoty.

• Postup výpočtu rozptylu: Máme-li dané hodnoty, muśıme ne-
jprve spoč́ıtat pr̊uměr z těchto hodnot. Následně spoč́ıtáme rozd́ıl
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naměřených hodnot od vypoč́ıtané pr̊uměrné hodnoty. Dále každý
rozd́ıl vynásob́ıme sám sebou (je-li rozd́ıl roven 3, pak spoč́ıtáme
3*3=9). Z těchto hodnot spoč́ıtáme pr̊uměr.

• př́ıklad: mějme naměřené hodnoty 1,3,5. Spoč́ıtejte rozptyl.
řešeńı: pr̊uměr z naměřených hodnot je roven (1+3+5)/3=3
rozd́ıly hodnot od pr̊uměru jsou 1-3,3-3,5-3, tj. -2,0,2
každý rozd́ıl vynásob́ıme sám sebou -2*(-2), 0*0, 2*2, tj. 4,0,4
pr̊uměr z předchoźıch hodnot 4,0,4 je roven (4+0+4)/3 = 2.67
rozptyl je roven 2.67

• Rozptyl je citlivý na extrémńı hodnoty.

• cvičeńı: spoč́ıtej rozptyl z hodnot 1,1,1,10

• cvičeńı: spoč́ıtej rozptyl z hodnot 1,1,1,1

Směrodatná odchylka

• Směrodatná odchylka je rovna odmocnině z rozptylu.

• Postup výpočtu: Nejprve spoč́ıtáme rozptyl, následně z rozptylu
spoč́ıtáme druhou odmocninu.

• př́ıklad: mějme naměřené hodnoty 1,3,5. Spoč́ıtejte směrodatnou
odchylku.
řešeńı: rozptyl je roven 2.67 (viz předchoźı př́ıklad)
druhá odmocnina z 2.67 je rovna

√
2.67 = 1.63

směrodatná odchylka je rovna 1.63

• Směrodatná odchylka je oproti rozptylu vyjádřena v p̊uvodńıch
jednotkách měřeńı, tj. na té samé škále, na které měř́ıme hodnoty
proměnné.

• Směrodatná odchylka je citlivá na extrémńı hodnoty.
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• cvičeńı: spoč́ıtej směrodatnou odchylku z hodnot 1,1,1,10

• cvičeńı: spoč́ıtej směrodatnou odchylku z hodnot 1,1,1,1

Variačńı rozpět́ı

• Variačńı rozpět́ı je rovno rozd́ılu maxima a minima, k němuž
přičteme 1.

• př́ıklad: spoč́ıtej variačńı rozpět́ı z hodnot -2,3,-10,6,9
řešeńı: variačńı rozpět́ı je rovno 9 - (-10) +1 =20

• cvičeńı: spoč́ıtej variačńı rozpět́ı z hodnot -4,9,0,63,5,-50,-31,2

Gretl a datove soubory

• Pro splněńı všech následuj́ıćıch př́ıklad̊u je nutné využ́ıt nějaký
statistický software. V našich přednáškách využijeme Gretl.

• natáhnut́ı dat do Gretlu: File →Open data Import →Zvolte
formát, ve kterém máte data uložená (např. .xls pro Excel, .csv
pro comma separated soubor)

• Gretl se Vás může při natahováńı dat zeptat ”The imported data
have been interpreted as undated (cross-sectional). Do you want
to give the data a time-series or panel interpretation?” Ve všech
datových souborech, se kterými budeme během hodin pracovat,
nejsou data uspořádána ani jako časová řada ani jako panel. Je
tedy nutno zvolit odpověď ”No”.

• všechny datové soubory, které budeme použ́ıvat, lze naj́ıt v ex-
celovském souboru metodologie data.xls na jednotlivých listech;
jednotlivé datové soubory lze naj́ıt jako .csv soubory (viz zla-
ryba.cz/hanicka/metodologie)
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Př́ıklad (data 01 descriptive normal IQ.csv)

V datovém souboru jsou hodnoty IQ pro pět set individúı.

1. Sestavte tabulku četnost́ı (absolutńıch, relativńıch a kumula-
tivńıch), kde velikost jednoho tř́ıd́ıćıho intervalu je rovna 5 a
minimálńı hodnota je rovna 50. Určete modus.

2. Sestavte tabulku četnost́ı (absolutńıch, relativńıch a kumula-
tivńıch), kde je počet interval̊u roven 11.

3. Reprezentujte data graficky pomoćı histogramu, v němž velikost
jednoho tř́ıd́ıćıho intervalu je rovna 5 a minimálńı hodnota je
rovna 50.

4. Reprezentujte data graficky pomoćı histogramu, v němž je počet
interval̊u roven 11.

5. Znázorněte data graficky pomoćı boxplot. Určete minimum,
prvńı kvartil (hodnota, po ńıž lež́ı 25 % všech hodnot), medián,
třet́ı kvartil (hodnota, pod ńıž lež́ı 75 % všech hodnot) a maxi-
mum.

6. Spoč́ıtejte pr̊uměr, medián, minimum, maximum, standardńı od-
chylku a roztyl.

7. Zvonovitý tvar histogramu indikuje normálńı rozložeńı zkoumané
veličiny. Na základě histogramu pro IQ posuďte, zda má tato
veličina tendenci být normálně rozložená.

Řešeńı

1. Gretl: Variable →Frequency distribution →Minimum value, left
bin zvol 50 a Bin width zvol 5
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Frequency distribution for IQ, obs 1-500

number of bins = 20, mean = 99.3317, sd = 14.679

interval midpt frequency rel. cum.

< 55.000 52.500 0 0.00% 0.00%

55.000 - 60.000 57.500 3 0.60% 0.60%

60.000 - 65.000 62.500 2 0.40% 1.00%

65.000 - 70.000 67.500 5 1.00% 2.00%

70.000 - 75.000 72.500 6 1.20% 3.20%

75.000 - 80.000 77.500 29 5.80% 9.00% **

80.000 - 85.000 82.500 38 7.60% 16.60% **

85.000 - 90.000 87.500 52 10.40% 27.00% ***

90.000 - 95.000 92.500 62 12.40% 39.40% ****

95.000 - 100.00 97.500 69 13.80% 53.20% ****

100.00 - 105.00 102.50 65 13.00% 66.20% ****

105.00 - 110.00 107.50 52 10.40% 76.60% ***

110.00 - 115.00 112.50 43 8.60% 85.20% ***

115.00 - 120.00 117.50 36 7.20% 92.40% **

120.00 - 125.00 122.50 16 3.20% 95.60% *

125.00 - 130.00 127.50 14 2.80% 98.40% *

130.00 - 135.00 132.50 2 0.40% 98.80%

135.00 - 140.00 137.50 4 0.80% 99.60%

140.00 - 145.00 142.50 1 0.20% 99.80%

>= 145.00 147.50 1 0.20% 100.00%

Modus je roven 97.5 (středńı bod=midpoint intervalu, který má
největš́ı četnost).

2. Gretl: Variable →Frequency distribution →Number of bins zvol
11

Frequency distribution for IQ, obs 1-500

number of bins = 11, mean = 99.3317, sd = 14.679

interval midpt frequency rel. cum.

< 63.015 58.440 4 0.80% 0.80%

63.015 - 72.165 67.590 9 1.80% 2.60%

72.165 - 81.315 76.740 46 9.20% 11.80% ***

81.315 - 90.465 85.890 80 16.00% 27.80% *****
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90.465 - 99.615 95.040 123 24.60% 52.40% ********

99.615 - 108.77 104.19 108 21.60% 74.00% *******

108.77 - 117.92 113.34 78 15.60% 89.60% *****

117.92 - 127.07 122.49 37 7.40% 97.00% **

127.07 - 136.22 131.64 11 2.20% 99.20%

136.22 - 145.37 140.79 3 0.60% 99.80%

>= 145.37 149.94 1 0.20% 100.00%

3. Gretl: Variable →Frequency plot →Minimum value, left bin zvol
50 a Bin width zvol 5

Figure 1: Histogram IQ 1

4. Gretl: Variable →Frequency plot →Number of bins zvol 11
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Figure 2: Histogram IQ 2

5. Gretl: View →Graph specified vars →Boxplot
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Figure 3: Boxplot

IQ

149.9

58.44

104.2

Klikni myš́ı na obrázek boxplotu, zvol Numerical summary

Numerical summary

mean min Q1 median Q3 max

IQ 99.332 58.44 89.248 98.74 109.41 149.94 (n=500)

6. Gretl: Variable →Summary statistic

Summary Statistics, using the observations 1 - 500

for the variable ’IQ’ (500 valid observations)
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Mean 99.332

Median 98.740

Minimum 58.440

Maximum 149.94

Standard deviation 14.679

C.V. 0.14778

Skewness 0.11914

Ex. kurtosis -0.010735

7. Histogram IQ má zvonovitý tvar, což indikuje normálńı rozděleńı.

Cvičeńı (data 02 descriptive test oblibenost atd.csv)

Výzkumńık má záměr zkoumat vztah mezi skórem v testu z matem-
atiky a daľśıch proměnných jako je hodnoceńı respondent̊u o jejich
obĺıbenosti matematiky (škála: 1=velmi obĺıbená až 5=zcela neobĺıbená),
hodnoceńı respondent̊u toho, jak jim přijde matematika obt́ıžná (škála:
1=velmi obt́ıžná až 5=velmi snadná), bydlǐstě (1=město, 0=vesnice)
a pohlav́ı (1=žena, 0=muž). Výzkumńık provedl náhodný výběr 33
student̊u, od kterých sebral všechny údaje. Zpřehledněte data pomoćı
deskriptivńı statistiky. Konkrétně se můžete zaměřit na následuj́ıćı:

• Sestavte tabulku četnost́ı (absolutńıch, relativńıch a kumula-
tivńıch) pro všechny proměnné.

• Spoč́ıtejte pr̊uměr, medián, minimum, maximum, standardńı od-
chylku a roztyl.

• Reprezentujte data pomoćı vhodně zvoleného grafu (histogram,
sloupcový graf atd.)

”Deskriptivńı statistika je deskriptivńı.” Použ́ıvej jen takové mı́ry
polohy a variability, které slouž́ı k zpřehledněńı dat a účelu tvé studie.
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2.2.4 Korelačńı koeficient

• Korelačńı koeficient udává mı́ru lineárńıho vztahu mezi dvěma
proměnnami.

• Jeho hodnoty se pohybuj́ı mezi -1 a 1.

• Podle znaménka korelace (”+” či ”-”) můžeme usoudit, zda je vz-
tah mezi proměnnými kladný či záporný. Negativńı hodnota ko-
relačńıho koeficientu naznačuje, že vztah mezi dvěma proměnnými
je záporný, tj. zvětš́ıme-li hodnotu jedné proměnné, zmenš́ı se
hodnoty druhé proměnné. Pozitivńı hodnota korelačńıho koefi-
cientu naznačuje, že vztah mezi dvěma proměnnými je kladný, tj.
zvětš́ıme-li hodnotu jedné proměnné, zvětš́ı se hodnota i druhé
proměnné.

• Vzdálenost korelačńıho koeficientu od nuly indikuje těsnost lineárńıho
vztahu mezi dvěma proměnnými:

– do 0.2 - lineárńı vztah je zandebatelný

– od 0.2 do 0.4 - lineárńı vztah je nepř́ılǐs těsný

– od 0.4 do 0.7 - lineárńı vztah je středně těsný

– od 0.7 do 0.9 - lineárńı vztah je velmi těsný vztah

– od 0.9 - lineárńı vztah je extrémně těsný

• Je-li hodnota korelačńıho koeficientu ńızká až nulová, neznamená
to, že mezi proměnnými nemůže být žádný vztah. Znamená to
pouze, že mezi veličinami je lineárńı vztah zanedbatelný.

• Vysoká hodnota korelačńıho koeficientu nemuśı znamenat, že je
mezi proměnnými kauzálńı vztah. Znamená pouze predikčńı vz-
tah.
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Figure 4: Korelace - zdroj http://cs.wikipedia.org/wiki/Korelace

Př́ıklad (data 03 korelace vek plat.csv)

Výzkumńık chtěl zjistit mı́ru lineárńıho vztahu mezi věkem a platem.
Náhodně vybral 19 respondent̊u, kterých se dotázal na jejich věk a
hodinový plat. Následuj́ıćı tabulka shrnuje źıskané údaje:
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respondent vek plat

1 30 116
2 45 140
3 32 119
4 56 152
5 60 157
6 23 105
7 25 110
8 48 142
9 57 158
10 63 166
11 49 145
12 52 149
13 61 161
14 44 135
15 36 126
16 53 147
17 35 125
18 63 164
19 49 145

Vypč́ıtejte korelačńı koeficient. Jaký směr má vztah mezi věkem a
platem (kladný, záporný)? Jak těsný je vztah mezi věkem a pohlav́ım
(zanedbatelný, nepř́ılǐs těsný vztah, středně těsný vztah, velmi těsný
vztah a extrémně těsný vztah)?

Řešeńı
Gretl: View →Correlation matrix

corr(vek, plat) = 0.99647103

Under the null hypothesis of no correlation:

t(17) = 48.9478, with two-tailed p-value 0.0000

Korelačńı koeficient mezi věkem a platem je v našem př́ıkladu roven
0.996. Směr vztahu je kladný. Vztah je extrémně těsný.
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2.3 Inferenčńı statistika

2.3.1 Jednovýběrový t-test

Jednovýběrový t-test se použ́ıvá pro testováńı toho, zda-li je středńı
hodnota (pr̊uměr) v nějaké populaci rovna předem stanovené hodnotě.

Př́ıklad (data 04 ttest pocetzaku.csv)

Výzkumńık chtěl zjistit, zda-li je pr̊uměrný počet žák̊u v jedné tř́ıdě
odlǐsný od 20. Zaměřil se na populaci žák̊u v osmých ročńıćıch na
základńıch školách. Aby mohl provést tento test, provedl náhodný
výběr ze všech tř́ıd osmých ročńık̊u základńıch škol. U těchto tř́ıd
zjistil počet žák̊u ve tř́ıdě:
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tř́ıda počet

1 30
2 12
3 25
4 20
5 18
6 19
7 14
8 13
9 15
10 20
11 14
12 17
13 31
14 35
15 8
16 17
17 16
18 19
19 20
20 7
21 32
22 20
23 14
24 25
25 26
26 24
27 22
28 23
29 21

Na hladině významnosti 10 procent testujte, zda-li je pr̊uměrný
počet žák̊u ve tř́ıdě odlǐsný od 20.
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Řešeńı
Nulová hypotéza H0 : µ = 20, alternativńı hypotéza H1 : µ 6= 20

Gretl: Tools →Test statistic calculator →mean

Null hypothesis: population mean = 20

Sample size: n = 29

Sample mean = 19.8966, std. deviation = 6.82613

Test statistic: t(28) = (19.8966 - 20)/1.26758 = -0.0816108

Two-tailed p-value = 0.9355

(one-tailed = 0.4678)

Na hladině významnosti 10 procent nemůžeme zamı́tnout nulovou
hypotézu, protože p-hodnota 0.9355 je větš́ı než 0.1 (10 procent), tj.
nemůžeme ř́ıci, že pr̊uměrný počet žák̊u v jedné tř́ıdě je odlǐsný od 20.
(Žáky mysĺıme žáky osmých ročńık̊u základńıch škol.)

Cvičeńı (data 05 ttest obtiznost.csv)
Výzkumńık chtěl zjistit, jak hodnot́ı studenti prvńıch ročńık̊u gymnázíı
obt́ıžnost předmětu bilogie. Provedl náhodný výběr těchto student̊u.
Následně jim položil otázku, jak hodnot́ı obt́ıžnost předmětu bilogie na
rating škále od 1(velmi snadný předmět) do 10(velmi obt́ıžný předmět).
Hodnoceńı student̊u je shrnuto v následuj́ıćı tabulce:
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zak obtiznost

1 5
2 9
3 6
4 1
5 2
6 1
7 3
8 2
9 4
10 2
11 2
12 1
13 1
14 3

Na hladině významnosti 5 procent testujte, zda-li se hodnoceńı
obt́ıžnosti biologie lǐśı od 5 (ani snadný, ani obt́ıžný předmět).

2.3.2 Dvouvýběrový t-test

Dvouvýběrový t-test se použ́ıvá (mimo jiné) pro porovnáńı středńıch
hodnot (pr̊uměr̊u) ve dvou základńıch populaćıch (nezávislých popu-
laćıch). Toto porovnáńı provád́ıme na základě náhodného výběru z
jedné a následně náhodného výběru z druhé populace.
Př́ıklad (data 06 ttest spokojenost pohlavi.csv)

Výzkumńık chtěl zjistit, zda-li se lǐśı spokojenost se vzdělávaćım systémem
v dané zemi mezi ženami a muži. Provedl náhodný výběr jedenácti
žen a osmi muž̊u a zeptal se jich zda-li jsou spokojeni se vzdělávaćım
systémem. Své hodnoceńı měli respondenti uvést na rating škále od
jedné do pěti, na ńıž jedna reprezentovuje ”velmi nespokojen” a pět
”velmi spokojen”. Data, která výzkumńık źıskal jsou následuj́ıćı:
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ženy muži

4 5
5 1
2 2
1 2
5 3
4 2
2 1
3 3
2
1
2

Na hladině významnosti 5 procent testujte, zda-li je spokojenost
muž̊u a žen se vzdělávaćım systémem odlǐsná.

Řešeńı

• Testováńım odlǐsnosti pr̊uměrné spokojenosti muž̊u a žen muśıme
nejprve provést jiný test, abychom určili, zda je variance (rozptýlenost)
spokojenosti muž̊u a žen odlǐsná či nikoli. Závěr testu pro porovnáńı
dvou varianćı použijeme jako předpoklad pro testováńı pr̊uměrné
spokojenosti muž̊u a žen. Test pro porovnáńı dvou rozptyl̊u
nazýváme F-test pro porovnáńı dvou rozptyl̊u.

• Provedeńı F-testu pro porovnáńı rozptylu jedné populace σ2
1 a

rozptylu druhé populace σ2
2 na hladině významnosti 5 procent

Nulová hypotéza H0: σ1 = σ2, alternativńı hypotéza H1: σ1 6= σ2
Gretl: Tools →Test statistic calculator →2 variances

Null hypothesis: The population variances are equal

Sample 1:

n = 11, variance = 2.16364

Sample 2:
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n = 8, variance = 1.69643

Test statistic: F(10, 7) = 1.27541

Two-tailed p-value = 0.7684

(one-tailed = 0.3842)

P-hodnota je větš́ı než 0.05. Na hladině významnosti 5 pro-
cent tud́ıž nemůžeme zamı́tnout nulovou hypotézu o shodnosti
rozptyl̊u. T-test pro porovnáńı pr̊uměr̊u dvou populaćı provedeme
s předpokladem, že rozptyly (standardńı odchylky) v těchto dvou
populaćıch jsou shodné.

• Provedeńı t-testu pro porovnáńı dvou pr̊uměr̊u na hladině významnosti
5 procent
Nulová hypotéza H0: µ1 = µ2, alternativńı hypotéza H1: µ1 6= µ2
Gretl: Tools →Test statistic calculator →2 means (Předpoklad:
Zaškrtni okénko u ”Assume common population standard devi-
ation”)

Null hypothesis: Difference of means = 0

Sample 1:

n = 11, mean = 2.81818, s.d. = 1.47093

standard error of mean = 0.443502

95% confidence interval for mean: 1.83 to 3.80637

Sample 2:

n = 8, mean = 2.375, s.d. = 1.30247

standard error of mean = 0.460493

95% confidence interval for mean: 1.28611 to 3.46389

Test statistic: t(17) = (2.81818 - 2.375)/0.65239 = 0.679321

Two-tailed p-value = 0.5061

(one-tailed = 0.253)

P-hodnota je větš́ı než 0.05. Na hladině významnosti 5 pro-
cent tud́ıž nemůžeme zamı́tnout nulovou hypotézu o shodnosti
pr̊uměr̊u, tj. nemůžeme ř́ıci, že pr̊uměrná spokojenost se vzdělávaćım
systémem je muž̊u a žen odlǐsná.
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Cvičeńı (data 07 ttest esej mapa.csv)

Výzkumńık chtěl porovnat účinek dvou vyučovaćıch metod (psańı esej̊u
a využit́ı concept mapping) na to, jak studenti na konci kurzu rozumı́
vyučované látce. Aby mohl účinek těchto dvou metod porovnat, provedl
experiment. Rozdělil náhodně studenty do dvou skupin. Jedna skupina
měla během kurzu využ́ıvat ke strukturaci učiva eseje (během kurzu
museli studenti napsat dvě eseje) a druhá skupina měla využ́ıvat metodu
pojmového mapováńı (během kurzu museli studenti sestavit dvě po-
jmové mapy). Studenti tak během kurzu źıskávali nové vědomosti,
zamýšleli se nad novými otázkami a ke strukturaci a shrnut́ı svých
znalost́ı použ́ıvali buď eseje či mapy. Na konci kurzu šli ke zkoušce,
kde měli prokázat porozuměńı nově naučené látce. (Jako měř́ıtko
porozuměńı látce byla zvolena známka u zkoušky.) Výsledky student̊u
u zkoušky (známka 1 až 5) shrnuje následuj́ıćı tabulka:

esej mapa

1 2
1 3
2 1
3 1
3 2
2 2
1 3
3 1
4 1
4 2
3 1
2 2
4 1
3 1

1
2
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Přepokládejte, že studenti v obou skupinách jsou náhodným výběrem
z populace student̊u. Na hladině významnosti 10 procent testujte,
zda-li je účinek těchto dvou vyučovaćıch metod v populaci student̊u
odlǐsný.

2.3.3 T-test pro korelačńı koeficient

Př́ıklad (data 08 koreltest vzdelani prijem.csv)

Často zkoumaným vztahem v sociálńıch vědách je vztah mezi př́ıjmem
a vzděláńım. Abychom tento vztah mohli zkoumat, byl proveden
náhodný výběr patnácti osob z ekonomicky aktivńıch lid́ı (populace),
kteř́ı byli dotázáni na jejich vzděláńı (měřeno počtem let vzděláńı) a
jejich př́ıjem (měřeno v tiśıćıch). Následuj́ıćı tabulka shrnuje źıskaná
data:

individum vzděláńı př́ıjem

1 9 12
2 14 30
3 10 10
4 13 20
5 14 28
6 10 13
7 12 15
8 15 33
9 17 25
10 13 20
11 14 30
12 13 16
13 13 25
14 17 45
15 20 40

1. vypoč́ıtej korelačńı koeficient mezi vzděláńım a př́ıjmem
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2. testuj na hladině významnosti 5 %, zda-li je korelačńı koeficient
signifikantně odlǐsný od nuly
nulová hypotéza H0 : ρ = 0, alternativńı hypotéza H1 : ρ 6= 0

Řešeńı
Gretl: View →Correlation

corr(vzdelani, prijem) = 0.86691624

Under the null hypothesis of no correlation:

t(13) = 6.27081, with two-tailed p-value 0.0000

1. korelačńı koeficient mezi vzděláńım a př́ıjmem je roven 0.87

2. korelačńı koeficient je signifikantně odlǐsný od nuly na hladině
významosti 5%, protože p-hodnota 0.0000 je menš́ı než 0.05.

Cvičeńı

1. Z populace žák̊u osmých ročńık̊u byli náhodně vybráni tři žáci,
u nichž byla zjǐstěna známka z českého jazyka na vysvědčeńı
na konci osmého ročńıku a známka z testu, kterou dostali z
posledńıho ṕısemného testu z českého jazyka.

známka
žák vysvědčeńı test

1 1 2
2 2 3
3 3 7

Vypoč́ıtej korelačńı koeficient a testuj, zda-li je na hladině významnosti
5 % signifikantně odlǐsný od nuly.
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2. (data 09 koreltest vysvedceni test.csv) Z populace žák̊u osmých
ročńık̊u bylo náhodně vybráno patnáct žák̊u, u nichž byla zjǐstěna
známka z českého jazyka na vysvědčeńı na konci osmého ročńıku
a známka z testu, kterou dostali z posledńıho ṕısemného testu z
českého jazyka.

známka
žák vysvědčeńı test

1 1 1
2 2 3
3 2 1
4 1 1
5 3 3
6 4 4
7 2 3
8 3 3
9 4 4
10 1 2
11 1 1
12 1 1
13 3 3
14 3 5
15 4 4

Vypoč́ıtej korelačńı koeficient a testuj, zda-li je na hladině významnosti
5 % signifikantně odlǐsný od nuly.

3. Porovnej korelačńı koeficienty v předchoźıch dvou cvičeńıch. Porovnej
závěry test̊u (na hladině významnosti 5 %) o odlǐsnosti korelačńıho
koeficientu od nuly. Porovnej tyto dva závěry!

2.3.4 Ch́ı-kvadrát test

Př́ıklad (data 10 chitest nazor pohlavi.csv)
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Vyučuj́ıćı chtěl zjistit, zda-li souviśı názor student̊u o obt́ıžnosti kurzu
s pohlav́ım studenta. Náhodně vybral 166 student̊u, u kterých zazna-
menal názor na obt́ıžnost kurzu (obt́ıžné, snadné) a jejich pohlav́ı (viz
datový soubor nazor pohlavi). Na hladině významnosti 10 % testuj,
zda-li názor ohledně obt́ıžnosti kurzu souviśı s pohlav́ım studenta.

Řešeńı
Nulová hypotéza H0 : názor a pohlav́ı navzájem nesouviśı, alternativńı
hypotéza H1 : názor a pohlav́ı spolu souviśı

Gretl: View →Cross Tabulation

Cross-tabulation of nazor (rows) against pohlavi (columns)

[ 0][ 1] TOT.

[ 0] 42 33 75

[ 1] 27 64 91

TOTAL 69 97 166

Pearson chi-square test = 11.7349 (1 df, p-value = 0.000613377)

Na hladině významnosti 10 %(=0.1) zamı́táme nulovou hypotézu, protože
p-hodnota je menš́ı než 0.1 . Na hladině významnosti 10 %(=0.1) lze
ř́ıci, že názor ohledně obt́ıžnosti kurzu a pohlav́ı spolu navzájem sou-
viśı.

2.3.5 Lineárńı regrese

• slouž́ı k predikci či odhadu jedné proměnné Y na základě znalosti
daľśı proměnné X (proměnných)

• slovo ”lineárńı” označuje, že předpokládáme lineárńı vztah mezi
proměnnou Y a X, tj. proměnné mohou být reprezentovány
grafem scatterplot, v němž se body maj́ı tendenci nacházet kolem
př́ımky
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• tato př́ımka je nazývána př́ımkou lineárńı regrese

• tato př́ımka reprezentuje, jak souviśı změna proměnné X se změnnou
proměnné Y

Př́ıklad (data 11 regrese seminar zkouska.csv)

Vysokoškolský učitel chtěl zjistit, zda-li souviśı počet seminář̊u, které
student během semestru navšt́ıvil, s výsledným počtem bod̊u v zkouškovém
testu. U náhodného výběru 20 student̊u si zaznamenal počet navšt́ıvených
seminář̊u během semestru (rozmeźı 0-13) a počet bod̊u v zkouškovém
testu (rozmeźı 0-100 procent):

student pocet seminaru vysledek zk

1 0 3
2 13 50
3 5 40
4 13 90
5 13 70
6 12 100
7 11 97
8 4 20
9 2 10
10 10 56
11 9 80
12 13 90
13 12 78
14 14 83
15 1 2
16 4 24
17 10 80
18 3 34
19 0 7
20 1 2
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1. Uveďte popisné statistiky (pr̊uměr, medián, minimum, maxi-
mum a standardńı odchylka) pro obě zkoumané proměnné (počet
seminář̊u, výsledek u zkoušky)

2. Reprezentujte data pomoćı grafu scatterplot, zakreslete výběrovou
regresńı př́ımku (odhad regresńı př́ımky)

3. Na hladině významnosti 5 procent testujte, zda-li je koeficient
u počtu navšt́ıvených seminář̊u signifikantně odlǐsný od nuly,
tj. zda-li počet navšt́ıvených seminář̊u pomáhá signifikantně
vysvětlit výsledek ve zkouškovém testu

4. Interpretujte koeficient u počtu navšt́ıvených seminář̊u.

5. Jaký výsledek (počet bod̊u) ve zkouškovém testu může dle našeho
regresńıho modelu očekávat student, který navšt́ıvil 7 seminář̊u?
Jaký výsledek může očekávat student, který navšt́ıvil 9 seminář̊u?

6. Porovnej predikci výsledku v testu pro studenta, který navšt́ıvil
9 seminář̊u se sebranými údaji vysokoškolského profesora. (Je
predikce výsledku shodná s daty, které učitel naměřil? Proč tomu
tak je?)

7. Je mezi početem navšt́ıvených seminář̊u a výsledku v zkouškovém
testu kauzálńı vztah?

Řešeńı

1. Gretl: View →Summary statistics

Summary Statistics, using the observations 1 - 20

for the variable ’pocet_seminaru’ (20 valid observations)

Mean 7.5000

Median 9.5000

Minimum 0.0000

Maximum 14.000
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Standard deviation 5.1759

C.V. 0.69011

Skewness -0.21497

Ex. kurtosis -1.6057

Summary Statistics, using the observations 1 - 20

for the variable ’vysledek_zk’ (20 valid observations)

Mean 50.800

Median 53.000

Minimum 2.0000

Maximum 100.00

Standard deviation 35.691

C.V. 0.70258

Skewness -0.11800

Ex. kurtosis -1.5362

2. Gretl: View →Graph specified vars
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Figure 5: Scatterplot

3. Gretl: Model →Ordinary least squares

Model 1: OLS estimates using the 20 observations 1-20

Dependent variable: vysledek_zk

coefficient std. error t-ratio p-value

--------------------------------------------------------------

const 3.25088 5.77839 0.5626 0.5807

pocet_seminaru 6.33988 0.639287 9.917 1.01E-08 ***

Mean of dependent variable = 50.8

Standard deviation of dep. var. = 35.6911

Sum of squared residuals = 3744.4

Standard error of the regression = 14.423

Unadjusted R-squared = 0.84529
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Adjusted R-squared = 0.83670

Degrees of freedom = 18

Log-likelihood = -80.7016

Akaike information criterion (AIC) = 165.403

Schwarz Bayesian criterion (BIC) = 167.395

Hannan-Quinn criterion (HQC) = 165.792

• Výběrová regresńı př́ımka je: V = 3.25 + 6.34S, kde S je
počet seminář̊u a V je výsledek u zkoušky

• Koeficient u počtu seminářu je tedy roven 6.34. Tento koefi-
cient je signifikantně odlǐsný od nuly na hladině významnosti
5 procent, protože p-hodnota 1.01E−08 je menš́ı než 0.05 (5
procent). (Porovnej tento závěr se záverem testu o tom, zda
je korelačńı koeficient mezi počtem seminář̊u a výsledkem u
zkoušky signifikantně odlǐsný od nuly na hladině významnosti
5 %.)

4. Pokud se počet navšt́ıvených seminář̊u zvýš́ı o jeden, lze očekávat,
že percentuálńı výsledek ve zkouškovém testu v pr̊uměru o 6.34
procentńıho bodu.

5. Predikce výsledku testu pro studenta, který navšt́ıvil 7 seminář̊u
je roven 3.25+6.37*7=47.84 procent. Predikce výsledku testu pro
studenta, který navšt́ıvil 9 seminář̊u je roven 3.25+6.37*9=60.58
procent.

6. Vysokoškolský učitel má ve svém výběru jednoho studenta, který
navšt́ıvil 9 seminář̊u. Jeho výsledek ve zkouškovém testu je 80
procent. Dle našeho modelu lze pro studenta, který navšt́ıvil 9
seminář̊u predikovat výsledek 60.58 procent. Rozd́ıl mezi těmito
závěry lze vysvětlit např. chybou měřeńı výsledku studenta. Je
možné, že při opravě testu či zaznamenáváńı výsledku tohoto
studenta udělal učitel chybu. Daľśım d̊uvodem by mohlo být, že
použitý model linearńı regrese neńı správným modelem pro tuto
situaci. Je možné, že jiný model vysvětluje výsledek testu na
základě počtu seminář̊u přesněji.

36



7. Daný vztah mezi počet seminář̊u a výsledkem v testu je predikčńım
vztahem. Na základě počtu seminář̊u predikujeme výsledek v
testu. O kauzálńım vztahu nelze jednoznačně nic ř́ıci. Nemůžeme
tedy ř́ıci, že zvýšeńı počtu seminář̊u o jeden je př́ıčinnou zvýšeńı
výsledku v testu o 6.34 procentńıho bodu. (Př́ıčinou dobrého
výsledku u zkoušky může být např. velká ṕıle studenta. Proměnná
pilnost studenta však v našem regresńım modelu neńı zahrnuta.
Tato proměnná je však korelována s počtem navšt́ıveným seminář̊u,
který v našem modelu je zahrnut. Reálně tak může být vliv počtu
seminář̊u na výsledek u zkoušky nesiginifikantńı (nevýznamný;
neńı signifikantně odlǐsný od nuly). Ale vzhledem ke korelaci s
nepozorovanou proměnnou ṕıle studenta vyjde v modelu koefi-
cient u počtu navšt́ıvených seminář̊u nadhodnocený a signifikantně
odlǐsný od nuly.)

Cvičeńı (data 12 regrese test IQ konzultace.csv)

1. Učitel chtěl zjistit vztah mezi počtem hodin, které s ńım student
konzultoval, a výsledkem v testu z matematiky. Provedl náhodný
výběr dvaceti student̊u, u kterých si zaznamenal percentuálńı
výsledek v testu a počet hodin, které student využil pro konzul-
továńı př́ıklad̊u, kterým v pr̊uběhu semestru méně nerozuměl.
Proměnnou, kterou učitel nepozoroval je výše IQ. Všechna data
(tj. ta, které učitel měl i neměl k dispozici) shrnuje následuj́ıćı
tabulka:
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student test IQ konzultace

1 71.32 89 2.1
2 78.58 96 1.4
3 74.50 91 1.5
4 93.64 116 4.2
5 75.34 92 2.2
6 83.06 102 1.8
7 72.34 89 0.7
8 79.06 98 1.3
9 78.30 97 0.0
10 77.66 97 2.3
11 84.88 101 2.9
12 65.20 80 0.5
13 82.54 101 2.2
14 94.28 116 3.4
15 79.78 98 2.4
16 76.00 93 3.0
17 80.82 98 2.6
18 87.18 108 3.4
19 92.04 112 3.2
20 77.92 95 1.1

(a) Uveďte popisné statistiky (pr̊uměr, medián, minimum, max-
imum a standardńı odchylka) pro proměnné, které učitel měl
i neměl k dispozici (výsledek v testu, počet konzultačńıch
hodin a IQ).

(b) Reprezentujte data pro výsledek v testu a počet konzultačńıch
hodin pomoćı grafu scatterplot, na vodorovnou osu naneste
počet konzultačńıch hodin a na svislou osu výsledek v testu.
Zakreslete výběrovou regresńı př́ımku (odhad regresńı př́ımky).

(c) Na hladině významnosti 5 procent testujte, zda-li je ko-
eficient u počtu konzultačńıch hodin signifikantně odlǐsný
od nuly, tj. zda-li počet konzultačńıch hodin pomáhá sig-
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nifikantně vysvětlit počet bod̊u ve testu

(d) Interpretujte koeficient u počtu konzultačńıch hodin.

(e) Jaký výsledek (počet bod̊u) ve zkouškovém testu může dle
našeho regresńıho modelu očekávat student, který konzul-
toval s učitelem 50 minut?

(f) Nyńı se zaměř́ıme na proměnnou, kterou učitel nepozoroval,
tj. IQ. Znázorněte graficky vztah mezi IQ a výsledkem v
testu z matematiky.

• Odhadněte model lineárńı regrese pro IQ jako vysvětluj́ıćı
proměnnou a výsledek v testu jako vysvětlovanou proměnnou.

• Je koeficient u výsledku v testu signifikantńı na hladině
významnosti 5 procent?

(g) Model lineárńı regrese lze použ́ıt i v př́ıpadě, kdy máme
v́ıce než jednu vysvětluj́ıćı proměnnou. V našem př́ıpadě
budeme cht́ıt vysvětlit výsledek v testu pomoćı počtu konzultačńıch
hodin i IQ.

• Odhadněte model lineárńı regrese, kde jako vysvětluj́ıćı
proměnné (independent variables) použijete počet konzultačńıch
hodin a IQ, tj. odhadni parametry a,b,c v rovnici vysledek = a
+ b*IQ + c*konzultace.

• Jsou jsou odhadnuté koeficienty u IQ a počtu hodin
konzultaćı signifikantně odlǐsné od nuly.

• Jaká je interpretace těchto koeficient̊u?

• Porovnej signifikanci a interpretaci koeficientu u konzultačńıch
hodin v dvou regresńıch modelech: modelu, který má
jednu vysvětluj́ıćı proměnnou (počet konzultačńıch hodin),
a modelu, který má dvě vysvětluj́ıćı proměnné (počet
konzultačńıch hodin i IQ).

• Je vztah mezi počtem konzultačńıch hodin a výsledkem
v testu kauzálńı?
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